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INTRODUCTION 

In this Tutorial, which we've designed to familiarize you with the 
basic operations of Medley, you'll follow step-by-step instructions 
to create an attractive two-column newsletter. Any questions you 
may have after completing the Tutorial are probably answered 
within the Medley manual. (For information about the basic 
operation of your computer, please refer to your Apple llGS 
manual.) 

If you need to know how to start Medley on your computer, 
please see "Getting Started" in the manual. The "Tutorial" file is 
located on the Medley Program disk . If at any time you'd like to 
stop working on this tutorial, see "Quitting Medley" in the manual 
for information on how to save your document. 

The first computer screen you'll see after loading Medley will be 
the Finder Desktop. The "Finder" keeps track of information on 
your disks, and it functions very much like a real desktop. The 
tiny pictures, called icons, represent files, folders, and disk 
drives . You can move them around, like papers on your desk. 
But first, you need to learn about the mouse. (For more 
information on the Finder, see Apple llGS System Disk User's 
Guide, Chapter I .) 

~ II 
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THE MOUSE 

On a real desktop, you can touch anything you want to with your 
fingers. On the computer desktop, you can use the mouse to 
touch things. If you move the mouse to the right, a pointer on the 
screen also moves to the right. Move up, and the pointer moves 
up. Please spend some time getting used to moving the mouse 
and pointer. If you run out of desk space upon which to move the 
mouse, simply pick it up and then set it back down where you 
have space. The pointer on screen will not move until you set the 
mouse down again. 

Push the button on the mouse to let the computer know that you 
would like to select something. Pushing the mouse button is 
called "clicking." If you click on an icon on the Desktop, you 
"select" it, and the selected object becomes highlighted. When 
you tell your computer to do something, it applies your command 
to an object that's selected. (For more information about the 
mouse, refer to IIGS Owner's Guide, Chapter 3.) 

MENUS 

At the top of the Finder (and every Medley screen) you'll see a line 
of words: "File," "Edit," and so on . This row of words is called 
the "Menu Bar," and these words represent "menus." A menu is a 
list of choices, in this case, a li st of commands. Move the pointer 
up to the Menu Bar, click on File, and hold the button down. A 
menu will appear. When you let go of the button, the menu 
disappears. Hold the button down and move the pointer down the 
list. As the pointer touches a command, it becomes high lighted. 
This means it is "selected." If you let up on the mouse button, the 
selected command will be you r choice. 

Now, click on the Medley Disk icon . It will become highlighted. 
Next, select the Open command. When it is high lighted, let up on 
the mou se button . The Medley Disk icon will open up. A 
"window" will appear, which will allow you to see what's on the 
Medley disk. Next, click on the Medley File icon, go up to the 
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File menu again, and select Open. Now the computer will take 
you from the Finder into the Medley program. 

THE DOCUMENT 

Every separate project you do on Medley is called a "file" or 
"document. " Whenever you open the Medley program you will 
see a "document window," like this: 
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Please note the Menu Bar located at the top of the document 
window, and below that, a "Title Bar" that contains the word , 
"Untitled." Whenever you open the Medley program directly, it 
creates a new--untitled--file for you. If you were creating an 
entirely new document, you would start right here. In thi s 
Tutorial, however, some of the work has been done for you. 

To open the Tutorial file, move the pointer to the File menu and 
choose the Close Untitled command. The "Untitled" document 
window will disappear. Select the Open Document command 
from the File menu, and a "dialog box" will appear. 

THE DIALOG BOX 

When the computer needs information from you, a dialog box will 
usually appear so that you can "talk" to your computer. Notice 
that the pointer will move around the entire screen, but you can 
only work within the dialog box. 

At the top of the Open Document dialog box are the words, "Enter 
file name to open." In the large rectangle below those words, find 
the file named "Tutorial." Click on the word "Tutorial" once to 
select it, and then move the pointer to the word "Open" on the 
right side of the dialog box. "Open," like some other commands, 
appears inside a small box. These boxes are called "buttons." To 
select the highlighted "Tutorial" file, click the "Open button." 
The dialog box will disappear, and the Title Bar will now read 
"Tutorial. " 
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FORMATTING 

Notice that the "Tutorial" text has no special formatting . "Rulers" 
allow you to change the paragraph indent, tab settings, and 
margins for each individual paragraph in a Medley document. 
Under the Special Effects menu is the command Show Rulers. 
Choose it, and vertical and horizontal rulers will appear at the left 
and top sides of your document. 

hove beefed liD our line of '~~~:: ;::::,:::(.~ of mustard, our own s~ 
sour souer contributed b!,l our ... ..... "I.=====_..J 

be 1 ifill' these innovations make our products technico ll~ superior to all """rI. 01" I hove a report on m~ desk indicating that we nOH have 0 larger sharp of 
condilunt lIIorbt than GLORI A." 
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Move the pointer up to the horizontal ruler at the top of the 
document. The red triangle below the "0" tell s the computer how 
far to indent each new paragraph. Click on it, hold the mouse 
button down, and move the mouse to the right. The red triangle 
will move along with the pointer--you're "dragging" the triangle to 
where you want it. Let up on the mouse button and the first line 
of the paragraph will be indented the measured di stance. Now, 
move the red triangle back to "0". 

Changes in the Ruler settings only apply to the paragraph in which 
the cursor is blinking, so only one paragraph will now be 
indented . To make indenting changes to all paragraph s, tab 
settin gs should be used. To do thi s, however, you must first 
know how to "scroll" through a document. 

SCROLLING 

Your computer screen isn't large enough to di splay most 
documents in their entirety. Usually, only part of the document is 
visible, and to see the rest, you must "scroll" the text--move it up 
or down . On the right side of the document window is the 
proportional scroll box. It shows graphically what portion of the 
document you're looking at. Right now, since you're at the top of 
the document, the scroll box is at the top of the scroll bar. 

todo~ . 

has Iloved ahead of its primar~ compe titor in the 
Chairman of the Boord Dnd tm L~nn@ Gottschalk 

beefed up our line of eating accessories," she soid, "by adding 
new voril'tils of lustord, our OI'In shoved coconut (prepared in thE' 
Stotes), a sweet IJnd sour souee contributed by our Chinese mostu 

,and on eosy-pour catsup. 
be lieve these innovati ons rllnkf ou r produc t') technicD I III superior 

all others, and I hove a rE port on IIlJ desk indi cating th at Wl' nOIf hoye 
larger shore of the condiml'nt lIarket thon 6LORIR." 

oying Catsup 
chl'llists finall y puffe t ed on lOsJj-pour catsup 1 05t week, 
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You can scroll in three ways: 

1) Click and drag the scroll box inside the scroll bar. 
2) Click in the gray area within the scroll bar. 
3) Click on the arrows located on either side of the scroll box. 

An arrow moves the document a line at a time, each time you click 
on it. If you want to move more than one line at a time, but still 
want the line-by-line precision of the arrows, click and hold the 
button down. Clicking in the gray area within the scroll bar will 
scroll the document one screen length per click. 

(When you scroll through the "Tutorial" text, you'll notice a thick 
black horizontal line. This line is a "page break," telling you 
where one page ends and another begins.) 

MORE FORMATTING 

Please move your pointer into the text. The pointer will change 
when it is moved from the Ruler into the document window. 
Instead of an arrow, it will resemble a capital "I," and is therefore 
called the "I-beam." Click the mouse. A blinking cursor will 
appear where you clicked. The cursor does not move around the 
screen the way the I-beam or the pointer do. The blinking cursor 
tells you where text will appear when it is next entered. You can 
also use the arrow keys to move the cursor through the text. 
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Click and drag the scroll bar to the end of the document. Now, 
while holding down the SHIFT key , place the I-beam after the 
final character in "Tutorial," and click. Your entire document is 
now highlighted , and any changes you make on the ruler will 
affect the entire document. Position the pointer directly below the 
1/2" mark on the ruler and click. A tab marker will appear. 
Because you have selected the entire document, any time the Tab 
key is pressed the text will align itself to that marker. Now, click 
once anywhere in the document, and all of it will be deselected. 
Place the cursor in front of the second line of tex t ("Chowtime 
Resources ... "). Press the Ta b key and the first line will move 
over 1/2". Do not indent the line: "Chowtime Tops Them All." 
Now, scroll through the document, placing the cursor in front of 
the first line of each paragraph and then pressing the Tab key. 
The first line in every paragraph will now be indented 1/2". Do 
not indent "Playing Catsup." 



12 TUTORIAL 
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Since you've made important changes to the document, you 
should now save it. Select the Save As ... command from the File 
menu. A dialog box will appear. On the left of the dialog box, 
near the bottom, is a line that reads , "Enter file name to save:" and 
below that, highlighted inside another box, is the name of your 
document, "Tutorial." This is called the "edit box." Because the 
name "Tutorial" is selected, it means that any text that is entered 
will automatically replace it in the edit box. Please type 
"Chowtime." This will be the new title of the document. Now 
click the "Save button," and the document will be saved as 
"Chowtime." On the disk, the original document, "Tutorial," will 
remain as it was before you made any changes. 

NOTE: Save early, save often. Computer documents are very 
vulnerable. If the power goes OUi accidental/y, you could lose a 
lot of work . We recommend thai you save your work 
frequently. 

THE WORD PROCESSOR 

Medley combines text and graphics: you can type and edit text in 
the word processor (Text mode), and you can create and edit art in 
the Paint Tool. Every time you open a file in Medley, you 
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automatically begin in the Text mode. [n general, it's easier to 
enter your text first and to add graphics later. [n this tutorial , of 
course, some text has been entered for you. But let's experiment 
to help you get comfortable with the word processor. Let's 
rewrite the first sen tence of the "Chowtime" text. 

Move the [-beam in front of "its," and click to insert the cursor. 
Continue to hold the mouse button down, and drag the pointer to 
the right. As you drag, the text will become highlighted. 
Continue until you've selected "its primary competitor in the field 
of condiments," . Let up on the mouse button and press the 
Delete key. The highlighted phrase will vanish. 

Chowtim Tops The. Al l 
Chowtim Resources has !loved ahead of 

W[I1ilI1 [hoir.on of the Boord Qnd ctO 

"14e hove beehd up our line of eating occ{lssories," she said, "b~ adding r 
variHies of lustard, our Il'fln ShOVEd coconut (prepared in the United States), 

and sour sauce contributed b~ aur Chinese rmw chef, and on easy-pour 
" 

"lfe b~ 1 ie ve these innovations make our product s technicall ~ superior to 
and I hov~ a report onm lJ d~sk indicatinQ that we nOl'I hav~ Q inrger ~hore 

condiraent market thon GLORIA." 

Catsup 

The text you enter from the keyboard al ways appears to the left of 
the cursor, and the cursor will move along as you enter text. Type 
in "GLOR[A, the long-time industry leader in the condiment 
market". If you misspell a word, select it by moving the I-beam to 
the middle of the word and clicking the mouse twice rapidly. 
(This is called "double-clicking.") You can also "click and drag" 
to select a word. Then retype. Still another way to correct a 
mistake is to move the [-beam to the right of the character that you 
want to change, click to insert the cursor, and press the Delete 
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key. The character to the left of the cursor will be deleted, and 
new characters can then be inserted. 

CUT AND PASTE 

Let's change the "Chowtime" text by supporting our first sentence 
with some proof. Move the I-beam to the end of the third 
paragraph, and select "I have a report on my desk indicating that 
we now have a larger share of the condiment market than 
GLORIA." When the passage is highlighted, move the I-beam to 
the Edit menu and choose the Cut command. The selected 
passage will disappear because the computer has moved it to the 
"Clipboard." The Clipboard is a temporary holding area in the 
computer's memory for any text or art you want to move around 
in a document, or between documents. Anything on the Cl ipboard 
will vanish if you turn off the computer or if you move anything 
else to the Clipboard with Clll or Copy. 

Now place the cursor at the end of the first paragraph, and select 
the Paste command from the Edit menu. The passage that you cut 
from the third paragraph will appear in the first paragraph right 
where you put the cursor. Next, add spaces and quotation marks 
at the beginning of the inserted passage, before "I"; insert a 
comma after "GLORIA"; and finish the sentence with "she sa id." 
The first paragraph should now read, 

Chowtime Resources has moved ahead of GLORIA, the 
long-time industry leader in the condiment market, 
Chairman of the Board and CEO Lynne Gottschalk 
announced today. "I have a report on my desk indicating 
that we now have a larger share of the condiment market 
than GLORIA," she said. 

In the second paragraph, replace "she said" with "she went 011 to 
explain." Finish the third paragraph by deleting "all others, and", 
and replacing it with "those of our competitor." Remember to add 
final quotation marks. 
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(For more information on Cut and Paste, see "Deleting Text," 
"Moving Text," and "Copying Text" in the Medley manual.) 

CHANGING FONTS AND STYLES 

You can change the style and size of the words in your document 
very easily. The "Chowtime" text is already in a particular 
typeface, or font, called Shaston. All fonts come in different 
sizes. In the "Chowtime" text, the font size is 8. 

Size 8 is a good size for normal text, but what about headlines? 
Click and drag over the headline "Chowtime Tops Them All" to 
select it. This will be the largest headline. Select the Choose 
Font .. . command from the Font menu. From the dialog box that 
appears, you can choose a different font, a different sty le of type, 
or a different type size. Click behind any number that appears in 
the box below "Other size. " Press the Delete key to delete the 
number showing, and then en ter the number 25. Now, click in 
the box next to "Bold," and then click OK. The selected tex t will 
now be bold and size 25 . While it is still selected, go to the 
Format menu and choose the Centered command. The headline 
will now be centered within the left and right margins. 

iy superior to 
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The headline "Playing Catsup" should be larger, but not as large 
as "Chowtime Tops Them All." Click and drag the mouse to 
select the headline. Then go to the Font menu and select the 
Choose FOIi!' .. command. In this case, you will only change the 
size, not the fo nt or style. Move the pointer to the "Size" box and 
click on size "16." The number 16 will also appe,tr in the "Other 
Size" box to show that it has been selected. Click OK. When 
you are done, scroll to the top of the document. 

ART AREAS 

Art areas are regions around which text will always wrap . Art 
areas must be created in order to insert graphics and colored text 
into your document. Art areas can also be empty, and as such can 
serve as borders, or "column dividers" for columns of text. We 
will use an art area to create a "masthead," the space where the 
name of the newsletter will go. 

To create an art area, move the pointer to the Areas menu, and 
select the Add Art Round Rectangle command. The mouse pointer 
will become a small "+" when it is moved back into the text. 
Notice that the moving hash-marks in the rulers correspond to the 
pointer movement. Move the pointer to the top of the document, 
and click the mouse button when the hash-mark is on the 0" mark 
on both rulers. Click and drag, and the outline of a rectangle will 
stretch with the mouse movement. Stretch the rectangle until it is 
I 112" high and 6" wide. Release the mouse button and the 
rectangle will be placed in the document. The borders of the art 
rectangle will turn orange (gray on a monochrome monitor), and a 
tiny black square will appear on each side. 
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The orange borders mean that the an rectangle is selected. If an an 
area is selected, you can move it around in the document by 
placing the pointer inside the area, clicking, and dragging. A 
selected art area can also be cut or copied to the Clipboard. Or, 
you can adjust the size of the area by using the black squares 
called "pull tabs" on each side of the rectangle. To move a pull 
tab, click on it and drag. The side of the an area on which the pull 
tab is located will expand or shrink with the mouse movement. 

Since the ent ire width of the page can not be seen on the screen at 
one time, use the horizontal scroll bar to move to the right margin. 
Now, use the pull tabs to expand the art rectangle all the way 
across to the 7 112 " mark. Use the horizontal scroll bar to move 
back across the page so that the left margin is now visible. 

With the masthead an area accurately sized, we will leave it alone 
for the time being while we work with other an areas . 

Now, let's divide the "Chow time" tex t into two columns. (The 
space between columns is called a "gulter.") Select Add An 
Rectangle from the Areas menu. Place the cursor so that the 
hash-marks are on the 2112" mark on the vertical ruler, and on the 
35/8" mark on the horizontal ruler (below "Chowrime Tops Them 
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All.") Click and drag to create a rectangle that is 1/4" wide (37/ 8" 

mark on the ruler), and extends to the bottom of the screen. Let 
up on the mouse button and the text will wrap around the 
rectang le. Scroll the page down so that you can see the bottom 
pull tab on the art rectangle. Now, click on the pull tab, and then 
press the Shift / Option / Down Arrow keys at the same ti me. 
The rectangle will sta rt to expand downwards. When it stops 
flashing it has reached the bottom of the page (wh ich is now off 
the screen). The long, narrow art area now becomes the gutter. 
Scroll back to the top of the page. 

It File Edit Search Anas Font Format Special [fhc-ts Shortcuts 
o Ch"'ti.. en 
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To make the gutter's borders invisible, go to the Areas menu and 
choose Convert Art Areas. A dialog box will appear. Choose 
"tum off borders," click OK, and the dialog box wi ll disappear. 
You wi ll still see the borders of the rectangle, but that is because 
the area is still selected. Click anywhere in the text to de-select the 
area , and the borders will no longer be visible. 



C onv~1 tAms ... 

o don't chong£' contents 
@toort contents 
o to tnt contents 

TUTORIAL I 19 

(!) to rectongll' 
o tel round rectangle 
0'00,,1 
O topol,gon 

@Ilovetopage: [[J 
o dilP I" on 0 II pog" 

Next we will add an art area for a bar graph. Select Add Art 
Rectangle and place the cursor at 0" on the horizontal ruler, and 
5112" on the vertical ruler. Click and drag the rectangle so that it 
borders the 35/8" mark on the horizontal ruler, and the 8" mark on 
the vertical ruler. Let up on the mouse button. The left side of 
your new rectangle should be flush with the left margin, and the 
right side should be flush with the left edge of the gutter. We will 
come back to the bar graph later. 

Notice that the tab indents in the right column of text are no longer 
there. This is because the tab marker is set at the 1/2" mark, and 
the left margin of the right column now starts at the 37/8 " mark. 
Since the Tab keys are still imbedded in the text, all you need to 
do is to set a new tab marker. Choose Select All Paragraphs from 
the Shortcuts menu to quickly select the entire document. Now, 
position the pointer below the 43/8" mark on the ruler and click. A 
new tab marker will be placed on the ruler, and the first line of 
each paragraph in the right column will be indented 1/2" from the 
gutter. 
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Now we will work on page two. Scroll to the top of the second 
page and select Add Art Rectangle from the Areas menu. 
Position the pointer at the 0" mark on the vertical ruler and the 
35/8" mark on the horizontal ruler. Click and drag to create a gutter 
the same width as on page one. Stretch the gutter to the bottom of 
the page. Turn off the gutter borders with the Convert Areas 
command on the Areas menu. Since the entire document was 
selected when the second tab marker was inserted (on the first 
page), paragraphs in the right column of the second page will 
automatically have their first lines indented 1/2". 

The final art area will be an oval. Select Add Art Oval from the 
Areas menu. Position the pointer at the 2" mark on the horizontal 
and the 1" mark on the vertical ruler. Click and drag the area until 
the right side reaches the 51/2" mark, and the bottom reaches the 3" 
mark. Release the mouse button and the text will flow around the 
area. 
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TH E PAINT TOOL 

Until now, you've been working onl y in the Text mode. But it's 
time to stan creati ng graphics, and to do that, you need to go to the 
Paint Tool, If the art oval is not selected, click inside it to select it, 
and then choose Enter Paint Tool from the Ar ea s menu . (To 
enter the Paint Tool from the Text mode more qu ick ly, you can 
simply double-click inside the art area where you wish to work , 
Note that the double-click on ly works if the area is not already 
selected .) 

The Paint Tool is noticeably different from the Word Processor. 
Along the side of the documenl window is a group of icons called 
the Tool Box, At the top or bottom of the screen is a collec tion 
of colors and patterns called the Color Box. At the very top of 
the screen is a Menu Bar similar to the one used in the Text mode, 
but wilh many different commands. 
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The only active part of the screen is the art oval you have selected. 
Anything you do while in the Paint Tool will not affect the text or 
any other art area. If the Tool Box or the Color Box get in 
your way while you're working in the Paint Tool, or if they 
obscure art you want to see, choose Hide Both Boxes from the 
Special Errects Menu. 

You can think of the Tool Box as a collection of attachments that 
modify your mouse pointer. Any time you want to put something 
different on your mouse pointer, simply move the pointer to the 
Tool Box and cl ick on the appropriate icon. 

Now, click on the Pencil (the fourth icon down in the right-hand 
column) . Move the pointer back to the art area. The pointer will 
become a pencil. Click and drag . You're drawing! 

To change colors, go to the Color Box . In the Color Box, to 
the left of the group of colors and patterns, you'll see a small 
trapezoid. This trapezoid tells you which color or pattern is 
currently selected. When you click on a color or pattern, the 
trapezoid changes to match it. 
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The trapezoid has three independent color parts: the border color, 
the interior color, and the background color. The border color 
determines the color of these tools: the Pencil, the Paint Brush, 
the Text tool , the Straight Line tool, and the borders of "hollow" 
and "filled" shapes. The in terior color determines the color of 
these tools: the Paint Can, and the interior of any "fi lled" shapes. 
The background color determines the color which the Eraser 
leaves behind when it erases. 

The border of the trapezoid tells you what color paint the Pencil is 
using. If the border isn't black, click on the border of the 
polygon, and then click on black . Notice how the trapezoid 
border changes to black, but the inside of the trapezoid doesn't. If 
you click on the inside of the trapezoid and then choose another 
color, the interior of the trapezoid will change, but not the border. 

Please use the Pencil to draw your own catsup bottle and catsup. 
If you want to change the line thickness for the Pencil , click on 
one of the squares located in the "Border Palette" at the bottom of 
the Tool Box. The currently selected one will have a box around 
it. To choose a different one, click on the size you like. Your 
new selection will now have a box around it. 

If you make a mistake, the fifth icon down in the right-hand 
column of the Tool Box is the Eraser . When you select it, the 
pointer becomes a big square. Clicking and dragging the square 
inside the art area erases your art. If you want to erase everything 
in the art area, simply double-click on the eraser icon. If you only 
want to get rid of your most recent change to the art area, go to the 
Edit menu and select the Undo command. 
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When you've fini shed the catsup bottle , you need to fill it with a 
color. To do this, select the Paint Can. The mouse pointer is now 
a paint can. In the Color Box, click on the interior of the 
trapezoid, and then choose red (for catsup). Then move the 
pointer back to the catsup bottle. Make sure the tip of the paint 
spilling out of the paint can is inside the catsup bottle. Click, and 
the bottle will fill with red. Double-click outside the art area to 
return to the Text mode. 

TEXT IN THE PAINT TOOL 

Now we will return to the "masthead." Select the "masthead" art 
rectangle, and then choose Enter Paint Tool from the Areas 
menu. You will be re turned to the Paint Tool, but a new art area 
will now be active. Go to the Tool Box and se lect the Text tool 
(the "A" icon). Select Hide Tool Box from the Special Effects 
menu to see more of the art area. Move the pointer back into the 
art area and it will be a small "+". 

Make sure you have the right typeface and the correct type size. 
Go to the Font menu and select Choose Font. Choose "Shaston" 
from the Font box, "Bold" from under the Style list, and "30" 
from the Other Size box. Click OK. 
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Text can be created in any color. Choose a shade of green from 
the Color Box. Click in the art area and a flashing cursor will 
appear. Text can be entered in the same manner as in the Texl 
mode, and will appear to the right of the cursor. Type the title of 
the newsletter, "THE CHOW TIMES." If you make a mistake, 
use the Delete key, or Undo from the Edit menu. 

Now select Show Tool Box from the Special Effects menu. To 
position the text in the art area precisely, choose the Seleclion 
Box. The pointer will become a small "+". Click and drag to 
draw a box around the text. Let up on the mouse button and the 
borders of the box will start to move. Position the pointer inside 
the moving borders, and click and drag. The text will now move 
with the mouse. 
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Next, you will enter "Everything fit to eat," and "Vol. IV, no. 6." 
Be sure to go to Choose Fane from the Font menu, change the 
Font size to "8," and the style to Plain . With the Seleclion Box, 
reposition "Everything fit to eat" and "VoI.JV, no. 6" below the 
name of the newsletter, in opposite comers of the masthead. 
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DETAILED DRAWING 

Perhaps you've made a few mistakes so small that they can't be 
easily fixed with the eraser. But you can clean up your picture by 
using the Magnifying Glass. The Magnifying Glass enlarges 
small sections of your artwork up so you can edit very small parts 
of it. This kind of editing gives your work a much more polished 
look. 
~~~~~~~--------------, 

Select the Magnifying Glass. The mouse pointer will turn into a 
large, see-through square. Move the square over the part of the 
picture you want to edit, and click. A dialog box will appear, with 
the selected area enlarged in a grid. The section you're working 
on will appear at actual size on the left. The mouse pointer has 
become a pencil. To edit, simply click on the squares in the grid 
with the pencil. The squares will change to the color selected in 
the Color Box at the bottom of the window . To change the 
selected color, click on your choice with the pointer. If you want 
nothing to show at all, choose white. Borders of art areas will 
appear in the Magnifying Glass as large purple "x's," and you 
can't change them with the penci l. When you are finished editing, 
click OK, and you will be returned to the Paint Tool . Now, 
double-click outside the art area to return to the Text mode. 
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IMPORTING ART 

There is one last art area to complete before we put the finishing 
touches on "The Chow Times", and that is to import a piece of 
"Clip Art." Scroll to page I and select the art area in the left 
column. Go to the Special Effects menu and select the Import 
Art ... command. A dialog box will appear with the art file "Bar 
Graph" listed in it. Click on "Bar Graph" to highlight it, and then 
click the "0 pen button." You will be returned to the word 
processor, and a bar graph will appear in the selected art area. If 
the art area is too small or too large, you can use the pull tabs to 
resize it. 
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Now that all the art and columns have been added, you can adjust 
the text to give your document a more professional look. First 
make sure that no art area are selected. Next, select all text in the 
document by choosing Select All Paragraphs from the Shortcut 
menu. Go to the Format menu and choose the Justified 
command. All text within the document will now be fully justified 
(no ragged edges) . However, the two headlines should be 
centered, and not justified. Select "Chowtime Tops Them All," 
and then select the Centered command from the Format menu. 
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Notice that the headline touches the border of the "masthead." 
While the headline is still selected, you can move it away. Select 
the Change Leading command from the Format menu. In the 
"Top of Leading" box enter the number 1, and then click OK The 
headline text will now move down one pixel from the "masthead" 
border. Center the headline "Playing Catsup" just as you did with 
the first headline. 
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A newspaper or magazine allots space on every page for its name. 
This space is called a "header," because it heads every page 
(except the first one). Your newsletter will look more professional 
if it foHows this example. Select the Change Page Numbers 
command from the Format menu. A dialog box will appear. 
Choose the style of number by selecting" 12" in the "Style" box. 
Choose the number location by clicking on the "top centered" page 
configuration in the "Location" box. 
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Once page numbers are selected, they do not have to show on all 
pages. In this case, you will not want a page number on the first 
page. Leave the number" I" in the box next to "Number Page 1 
as." Change the boxes next to "Affect Pages" so that they read "2 
through 99." Page numbers will now start to appear on page two, 
starting with the number two. 

Text can appear on the same line as a page number, so that a 
header can be created. To create a header, enter "THE CHOW 
TIMES" in the "Even Pages" box below "Text Surrounding Page 
Numbers ." (Since there is no page three, you will not have to 
worry about odd pages.) The gray diamond represents the 
location of the page number within the line of text. Enter your text 
in front of the diamond. (Make sure that the cursor is flashing in 
front of it.) If the diamond is deleted, it can be placed back in the 
edit box by pressing the Option / # keys . Headers and footers 
will always print in Shaston 8. 

Finally, on page two, you'll notice that the text on the right side of 
the oval is too close to the border. You need to add space between 
the oval and the text. To do this, you'll need to make a slightly 
larger art oval. Select Add Art Oval from the Areas menu. 
Position the pointer at the 7/8" mru'k on the vertical ruler, and the 
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PIS" mark on the horizontal ruler. Click and drag to create an oval 
that is 1/8" larger on all sides. 

The new oval now covers the original. Obviously, you'll want to 
see your catsup bottle, so you must "shuffle" the new oval so that 
it is underneath the original. To do so, choose the command, 
Send to Back from the Areas menu, and the new oval will be 
"shuffled" so that it is underneath the original. 

The borders of the larger oval are still visible, and what we want is 
"white space" between art and text. Choose the "turn off borders" 
option from the Convert Art Areas command on the Areas menu 
to make the borders invisible. The text will now wrap about 1/8" 
away from the border of the catsup bottle an area. 

THE THRILL OF VICTORY 

You 're done! You 're now well on your way to becoming a 
Medley ex pen. Please refer to the section "The Finished Product" 
in the Medley manual if you need help printing your newsletter. 
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